
FiberChekPRO™ 2.5.0 

Version 2.5.0.6936 – October 2023 

What’s New 
• Added new built-in analysis profiles for IEC Edition 3: 

• MM (Ed 3 IEC-61300-3-35) 

• Ribbon MM (Ed 3 IEC-61300-3-35) 

• Ribbon SM APC (Ed 3 IEC-61300-3-35) 

• SM APC (Ed 3 IEC-61300-3-35) 

• SM PC RL35 (Ed 3 IEC-61300-3-35) 

• SM PC RL45 (Ed 3 IEC-61300-3-35) 

• SM PC and Stub (Ed 3 IEC-61300-3-35) 

• Added new default optical settings for FiberChek™ and P5000i probes: 

• FBPT-FEBS10-R (with BAP1) 

• FBPT-FITDP-R (with BAP1) 

• FBPT-FSTCON (with BAP1) 

• FBPT-PRODIGY 

• Mil/Aero guides (with BAP1-G) 

• FBPT-MIL-2CPA 

• Ribbon Tips - FBPT-COD 

• Added new default optical setting for Sidewinder™ probe: 

• FCPT-MMCA-C 

• Added option to export optical settings with the *.tip.xml file extension. 

What’s Changed 
• FiberChekPRO no longer supports SmartClass Fiber devices, with the notable exception of OLP-82, OLP-

82P, HD4i, and HD4iP. Use J-Reporter instead (https://j-reporter.updatemyunit.net). 

What’s Fixed 
• Fixed bug where battery level of a hosted device was being reported incorrectly when system was set to 

a language with European number formats. 

• Fixed bug where pass/fail criteria could be applied incorrectly when the system was set to a language 

with European number formats. 

• When unchecking “Find Scratches” in the profile editor, scratch pass/fail criteria will no longer be shown 

in the summary table. 

https://j-reporter.updatemyunit.net/


Known Issues 
• Image zooming and image attribute popups are not supported in HTML reports when viewed in 

browsers other than Internet Explorer. Open HTML reports using FiberChekPRO software to enable 

these features. Image attributes include ring and zone diameters and contamination diameters and 

area.  

• FiberChek Probe “screen dim” device settings are visible even if the attached probe microscope does not 

support screen dimming.  Changing those settings via FiberChekPRO will not change probe operation.  

 

FiberChekPRO™ 2.4.1 

Version 2.4.1.6892 – August 2022 

What’s New 
• Single-fiber PDF and HTML reports have a new design and layout and include the software and 

microscope firmware versions. The new report is not used for job mode reports or grouped reports 

imported from microscope storage. 

• LabVIEW example added to the Automation API code examples. 

• Option to hide Sidewinder/FVAm connector stitched images from reports. The default is to include 

stitched images. 

• Default optical settings for FiberChek™ and P5000i probes available for: 

• FBPP-EOB3 

• FBPT-DLX 

• Adding the line “IncludeAllUserInfoFieldsInXml = true” to the UserConfig.ini file in the FiberChekPRO 

install directory adds all user information fields to xml files when the “Save Archive Support Files” option 

is checked. 

What’s Fixed 
• Scratch detection accuracy and repeatability improved. 

• Scratch orientation has significantly less effect on scratch detection. 

• The ConnectionHelper.ConnectOrStartRemote function call no longer fails when invoked by LabVIEW.  

This function is part of the Automation Helpers API. 

• FVAi/FVDI-xxxx intermittent PC date/time synchronization failure fixed. 

• Zones summary table disappearing intermittently in the Profile Editor window fixed. 

• Default author removed from document properties in MPO PDF reports. 

• Broken links in job mode HTML reports that contain the pound character ‘#’ in the fiber base name are 

fixed. 



What’s Changed 
• Removed 780 nm from the list of OLP-82/82P and MP-60/80 default wavelengths. The allowable range 

for stored wavelengths is 800 – 1650 nm.  

• Deprecated StrataSync™ support.  Use FiberChekPRO version 2.3.3.6635 if StrataSync support needed. 

Known Issues 
• The inspection images are missing from single-fiber HTML reports when there is an apostrophe in one or 

more of the following user information fields: Company Name, Location, Operator, and Operator ID. 

• The inspection images are missing from single-fiber HTML reports when “IncludeAllUserInfoFieldsInXml 

= true” is added to the UserInfo.ini file and there is an apostrophe in any user information field. 

• The layout of Japanese language reports is misaligned when using the default Microsoft Windows 10 

fonts. The Supplemental Japanese Fonts must be installed to correct the issue. 

 

FiberChekPRO™ 2.4.0 

Version 2.4.0.6780 – December 2021 

What’s New 
• Added support for the new FVAi-2030 benchtop microscope 

• Added features to the analysis profile editor to support FVAi-2030: 

• Added optional ‘ferrule diameter’ and ‘automated polish area detection’ parameters, exclusively 

for FVAi-2030 

• Added the ability to show live microscope image behind the zones preview if an FVAi-2030 is 

actively connected 

• Added link to automation documentation and example code under the Help menu 

• Automation API updates: 

o Added new “Helpers API” in order to simplify the most common automation use cases, reducing 

the number of lines of code to write 

o Added several new API members 

o Added support for remote automation using LabVIEW 

o Updated the documentation and example code accordingly 

• Added full support for the new “V2” hardware variants of MP-60 and MP-80. The Firmware Update page 

now shows their correct firmware and hardware versions 

• Added new default optical setting named “FMAG-U25” for FVAm benchtop microscopes 

• Added new default optical setting named “FBPT-CEV-A6” for P5000i and FiberChek™ probes 

• Added new built-in analysis profiles specifically for the FVAi-2030: 

• FVAi-2030 SM 1.25 mm UPC (Polish detect) 

• FVAi-2030 SM 1.25 mm APC (Polish detect) 



• FVAi-2030 SM 2.5 mm UPC (Polish detect) 

• FVAi-2030 SM 2.5 mm APC (Polish detect) 

• FVAi-2030 MM50 1.25 mm UPC (Polish detect) 

• FVAi-2030 MM50 2.5 mm UPC (Polish detect) 

What’s Fixed 
• Fixed unauthorized access errors when the currently logged-in Windows user does not have write access 

to the FiberChekPRO archives directory. The software now detects this condition and shows a dialog to 

the user that allows them to change the archived directory to a new location to which they have write 

access. 

• An error message is no longer shown if a user cancels a Sidewinder inspection with the hardware trigger. 

• Firmware update and system reset no longer fail on machines that have FIPS (Federal Information 

Processing Standards) mode turned on. 

• Addressed several “file already in use” errors by showing a more helpful error message. 

• Improved user experience when the UI freezes by showing a dialog that gives the user a choice to wait 

for it to respond or just exit FiberChekPRO. 

What’s Changed 
• The Import tab is no longer automatically selected when a microscope that supports import is 

connected to FiberChekPRO. Instead, the Microscope tab is automatically selected first. However, the 

old behavior may be reinstated by going to Setup > FiberChekPRO... > User Interface, and checking the 

box next to “Automatically select Import Tab.” 

Known Issues 
• StrataSync™ sync is not operational in this release. If you wish to use StrataSync, use FiberChekPRO 

version 2.3.3.6635. 

• If an older version of FiberChekPRO is installed in the same folder as FiberChekPRO 2.4.0, the older 

version may crash at startup. To downgrade FiberChekPRO versions, either uninstall the newer version 

first or follow these steps: 

1. Navigate to the folder “C:\ProgramData\Viavi\FiberChekPRO\ResourceCatalog”. 

2. Delete all the files with the extension “.json”. 

3. Delete the file FVAi-2030.fwp if it exists. 

4. Delete the file FVAi-2030.frp if it exists. 

• The MP-60 and MP-80 have a minimum wavelength setting of 800 nm, but FiberChekPRO allows setting 

custom wavelengths as low as 780 nm. If a wavelength below 800 nm is added to the device, it cannot 

be selected. 

• The MPO connector stitched image from Sidewinder and FVAm is unavailable when the device needs to 

re-image one or more fibers after the initial image acquisition. 

  



FiberChekPRO™ 2.3.3 

Version 2.3.3.6635 – June 2021 

What’s Fixed 
• Fixed occasional errors when exiting the settings screens 

• Several minor bug fixes 

 

FiberChekPRO™ 2.3.2 

Version 2.3.2.6565 – March 2021 

What’s New 
• Added new default optical settings for Sidewinder™ probe: 

• FCPT-LC 

• FCPT-QODC2-P 

• FCPT-QODC2-S 

• Added a new default optical setting for P5000i and FiberChek™ probes: 

• VSFF APC Tips 

• Updated the Automation API documentation (located in the Automation subfolder of the FiberChekPRO 

install folder): 

• Added new FAQ section 

• Added section on Remote Automation 

• Added example projects listing 

• Miscellaneous edits and organizational changes 

• Updated the Automation API example code, also located in the Automation subfolder: 

• Added an example Python script 

• Updated TestFiberSaveResult.cs 

What’s Fixed 
• Fixed incorrect IEC table references in the notes for IEC profiles  

• Fixed a language support issue when saving Sidewinder reports 

• Fixed an issue with job definitions imported from Excel missing last row and column if first row and 

column completely blank  

• Improved fiber core handling for both single-mode and multimode fibers 

• Improved detection of particles near the cladding edge 

• Miscellaneous bug fixes and reliability improvements 



FiberChekPRO™ 2.3.1 

Version 2.3.1.6360 – March 2020 

What’s New 
• The redesigned MPO report introduced in version 2.3.0 is now available for both HTML and PDF reports 

for all languages that FiberChekPRO supports. 

• Updated English User Manual. 

• Added new default optical settings for P5000i and FiberChek™ probes: 

• FBPT-E2A-A6 Ceramic 

• FBPT-E2A-A6 Metal 

• Improved analysis performance with P5000i and ULC-A6 tips. 

• Added support for the FiberChek™ probe’s new features (requires firmware 2.2.983.3387 or newer): 

• Auto Optical Setting mode 

• Ability to speed up firmware update by selecting a subset of its language packs 

• The dynamic sizing check box in the optical settings editor advanced options is now available for 

Sidewinder and FVAm microscopes. 

• Renamed built-in connector definition “SR4” to “SR4 (4-0-4)”. 

What’s Fixed 
• Corrected the failure criteria for the built-in analysis profile “E2000 (metal ferrule)”. 

 

FiberChekPRO™ 2.3.0 

Version 2.3.0.6188 – September 2019 

What’s New 
• MPO Connector Stitched Image. View and report on the entire connector image for MPO tests from 

Sidewinder and FVAm microscopes (requires firmware 2.1.1921.3347 or later). Current limitations: 

• Only supported on connector definitions without any unpopulated/ignored fibers. The 

supported built-in connector definitions are MPO 12x1, MPO 12x2, MPO 16x1, MPO 12x2, MPO 

8x1, and MPO 8x2. 

• Redesigned MPO Report. New report design for MPO tests from Sidewinder and FVAm microscopes. 

The new report also includes the connector stitched image (requires firmware 2.1.1921.3347 or later). 

Current limitations: 



• The stitched image is not included on reports saved on the device and then imported into 

FiberChekPRO. 

• The old report design is used if the file format is set to PDF and FiberChekPRO’s language is set 

to either Chinese, Japanese, or Korean.  

• The old report design is used if the file format is set to HTML and the report is for a group stored 

on the device. 

• Stored groups on Sidewinder and FVAm containing simplex tests cannot be imported into 

FiberChekPRO 

• Auto-test On In Focus. The ability to automatically run a test when the fiber comes into focus (primarily 

for manual focus units). This can be enabled from the Microscope page under FiberChekPRO setup. 

• Auto Focus on Test if Necessary. If the focus bar is red or yellow when the Test button is pressed, Auto 

Focus is automatically run prior to the test. 

• Optical Setting Cladding Diameter. The ability to edit the cladding diameter in the optical setting editor. 

Current limitation: The cladding diameter edit box always defaults to 125 when you open the optical 

setting editor. 

• Automation API Updates. 

• Remote Automation. The ability to call the FiberChekPRO automation API from a separate 

Windows process on the same machine.  This enables lighter weight automation client code and 

the ability to call the API from a non-.NET language such as Python and LabView.  

• NOTE: The remote automation feature is still in the Beta phase and therefore may not 

always operate as expected. Contact technical support if you encounter problems with it. 

• New Example Code. A newly expanded set of automation example projects that illustrate the 

use of Windows Forms, WPF, console applications, plugins, and remote automation. 

• Show Number on Focus Meter. Optionally show the focus number on the focus meter in the live view. 

This can be enabled from the Microscope page under FiberChekPRO setup. 

What’s Fixed 
• Length measurements on reports imported from OLTS-85 are now reported correctly when the units are 

in feet. 

• Left/right panning arrows are now shown when using FVAm in simplex mode. 

• PDF password protection is now correctly applied to imported reports when the setting is enabled in 

Archiving Options under FiberChekPRO setup. 

• Improved optical settings auto-adjust process for non-standard cladding diameters. 

• The fiber type for the optical setting “FBPT-E2000-N Ceramic APC” is now Simplex instead of E2000. 

• Added “show centering limit” option to FVAi/FVDi device setup to fix the problem where the centering 

circle was not shown on the low mag live view. 

• Automation API: 

• Fixed cases where some message boxes where not being routed through the 

IApplication.PreviewMessageBoxShown event. 

• Changes to IUserInfo values are now committed when calling 

IWindow.CommitConfig(IFCProConfiguration). 

• Numerous minor bug fixes. 



What’s Changed 
• Simplified Analysis Profile Management. The analysis profile setup screens have been reorganized for 

more intuitive operation. 

• Analysis Profiles page under FiberChekPRO Setup:  

• Now only a single list showing all profiles stored on the PC, sorted alphabetically.  

• Removed the “associate microscopes” and “show profiles for” features because they are 

no longer relevant. 

• Unified the Analysis Profiles pages under device setup to be the same for all microscopes: 

• FVAi/FVDi Series: Removed the “associate microscopes” and “show profiles for” 

features because they are no longer relevant. 

• P5000i: Added an Analysis Profiles page under P5000i setup. This is the new location for 

managing the P5000i’s list of available profiles that show in the drop-down on the 

Inspection tab. 

 

 

  



FiberChekPRO™ 2.2.1 

Version 2.2.1.5885 – February 2019 

What’s New 
• Ability to perform System Reset on P5000i and FiberChek™ Probe. 

• Support for the new VIAVI FVAm-1000 and FVAm-1000-S benchtop MPO inspection microscopes. 

What’s Fixed 
• Bug fixes and reliability improvements. 

 

FiberChekPRO™ 2.2.0 (Maintenance Release 1) 

Version 2.2.0.5800 – November 2018 

What’s Fixed 
• Users of legacy devices that are no longer supported in 2.2 can now downgrade back to 2.1.1.5547 

without any issues. 

 

FiberChekPRO™ 2.2.0 

Version 2.2.0.5770 – November 2018 

What’s New 
• Firmware releases are now decoupled from the FiberChekPRO software releases. Firmware releases may 

be deployed and then utilized by the software without necessarily updating the software. 

• Ability to perform a System Reset on Sidewinder™ and FVAi/FVDi Series devices. For more information, 

see  System Reset & Firmware Update.pdf . 

• Ability to reduce firmware update time by selecting a subset of supported languages to load onto the 

device. (Sidewinder is currently the only device that supports this feature.) 

• Ability to create, edit, export and import Sidewinder connector definitions. 

• New signed USB drivers that are supported on Windows 10. 

http://fcpro.updatemyunit.net/archives/FCPRO/System_Reset_and_Firmware_Update.pdf


What’s Changed 
• Device settings screens have been reorganized for more intuitive operation. 

• Inspection reports generated from live operation (on the Inspection tab) include only the field values 

from the Company Info and Job Info screens in FiberChekPRO. Field values from the device’s User Info 

screen are not included on the report. (There is no change to the reports imported from device storage 

on the Import tab.) 

• The following devices are no longer supported in FiberChekPRO:  

• FBP Analog Probe Microscope (for example, FBP-P5 and FBP-P505 connected by a USB converter 

module)  

• FBP P5000 Digital Probe Microscopes  

• FVA/FVD Series Benchtop Microscopes  

The last version that supports these devices is version 2.1.1.5547. Note that all other VIAVI 

microscopes, including FBP-P5000i, FVAi/FVDi, FiberChek™, and Sidewinder will continue to be 

supported, as will the MP Series OPM, VP-60 and FI-60, and PowerChek™ OPM. 

What’s Fixed 
• Bug fixes and reliability improvements 

 

FiberChekPRO 2.1.1 (Maintenance Release 3) 

Version 2.1.1.5547 – August 2018 

What’s New 
• New Sidewinder firmware – 1.3.1641.3169 

• New connector definition MPO 8x2 [24], which is a 12x2 connector with only the center 16 fibers 

populated. 

• Two new default E2000 optical settings for the P5000i and FiberChek probes. 

What’s Fixed 
• Numerous bug fixes and reliability improvements 

Firmware Release Notes 

Sidewinder – 1.3. 1641.3169 

What’s New 

• MM Bright Core Particle Detection Enhanced 
• Scratch Detection Enabled  



• Includes support for Colorblind Mode 
• Assisted Manual Focus  

• When near peak focus, the resolution of the joystick is scaled for fine control 
• Menu Updates  

• Removed Autocenter Menu Option 
• Removed Date Format Menu 

• When reports are imported on a PC, the Windows date format on that machine will be 
used 

• Added Key Up/Key Down menu for tip alignment 
• Auto Lighting Mode beta is available  

• Dynamically adjusts lighting to optimize for current DUT 
• Will disable itself as soon as a host connects 
• Intended to be for standalone operation only 

• Device/host pairs should be less likely to erroneously time out 
• A double row fiber (or single row) that is out of center should now result in an inspection error 
• 8x2 [24] Connector definition added 

What’s Fixed 

• Numerous bug fixes and reliability improvements 

  



FiberChekPRO 2.1.1 (Maintenance Release 2) 

Version 2.1.1.5460 – June 2018 

What’s New 
• New Sidewinder firmware – 1.3.1557.3142 

• Changed the names of the following connector definitions: 

Old Name New Name 
MTP 12x1 MPO 12x1 
MTP 12x2 MPO 12x2 
MTP 16x1 MPO 16x1 
MTP 16x2 MPO 16x2 
MTP 8x1 MPO 8x1 

What’s Fixed 
• Minor bug fixes. 

Firmware Release Notes 

Sidewinder – 1.3.1557.3142 

What’s New 

• Support for the new FCPT-MTPA-L long reach ribbon tip 

• Ability to perform a pan motor calibration (Menu -> System Settings ->  Panmotor Calibration) 

• Improved fiber finding accuracy 

• Improved startup time 

• Added USB connect mode setting (Menu -> System Settings -> USB Connect Mode). This can be used 

to change the USB speed when there are USB connection issues. 

• Added Giteki Cert to the System Info screen for Japan compliance 

• Changed connector names from MTP to MPO (see table above) 

• INSPECT OUTSIDE ZONES menu removed 

• Improved image stability in the Optical Setting editor 

What’s Fixed 

• Numerous bug fixes and reliability improvements 

  



FiberChekPRO 2.1.1 (Maintenance Release 1) 

Version 2.1.1.5311 – April 2018 

What’s New 
• New firmware 

• P5000i – 1.6.1196.3112, 1.6.259.3112 

• Patch Cord Module of SmartClass Fiber devices (except OLP-82x/HD4ix Series) – 1.6.259.3112 

• OLP-82x/HD4ix Series – 1.6.1166.3112 

What’s Fixed 
• Bug fixes and reliability improvements 

  



FiberChekPRO 2.1.1 

Version 2.1.1.5280 – March 2018 

What’s New 
• Updated Sidewinder support: 

• Support for unpopulated fibers. Unpopulated fibers (those that are not expected to be 

populated per the connector type) are displayed as gray circled, and not-found fibers (those that 

the device expects to find but does not) are displayed as yellow triangles with an exclamation 

point. 

• Basic connector definition management with ability to copy between PC and on-device storage. 

• Deleting all stored results from the device is now much faster. 

• When generating reports from devices that store User Info, the User Info field values are taken from the 

device rather than from the PC. However, if a given User Info field on the device is empty, the value 

from the PC is used instead. 

• Ability to change the StrataSync server URL, which is necessary for EU customers. 

• New firmware 

• Sidewinder – 1.3.1490.3108 

What’s Fixed 
• Bug fixes and reliability improvements 

Firmware Release Notes 

Sidewinder – 1.3.1490.3108 

What’s New 

• Ability to rotate the screen UI. (Menu->System Settings->Screen Orientation) 

• Added menu icon to upper-left of live view. 

• Reorganized menu structure for better usability. 

• Improved fiber finding accuracy. 

• Improved user experience for on-board optical setting editor. 

• Support for connectors with unpopulated fibers (SR4/SR10). 

• New message to help guide users through switching between ribbon and simplex fiber kinds. 

• Moving the joystick now clears error messages. 

• Doubled the results storage capacity. 

  



FiberChekPRO 2.1.0 

Version 2.1.0.5181 – January 2018 

What’s New 
• Added support for the new FiberChek™ Sidewinder MPO inspection probe. 

• Sidewinder is currently only supported in Quick Test mode; it is not yet supported in Job mode. 

• Sidewinder test data is not yet able to be synced with StrataSync. 

What’s Changed 
• StrataSync changes: 

• Users must now login with their username and password. This replaces the former method of 

identification using an account ID and tech ID. Contact your StrataSync account administrator to 

obtain a username and password if you do not already have one. 

• Can now sync test data for all devices in with a single click, as well as test data for just one 

device at a time. 

• Added new “Sync with StrataSync…” menu item to the File menu. This will sync test data for all 

devices. 

• Increased the maximum allowable number of job definition cells from 2500 to 5000. 

• Added link to FiberChekPRO Diagnostics in the Help menu for convenience. (It can still be accessed from 

the Windows Start Menu as always.) 

• Added  shortcuts Shift+C+D and Shift+A+D to open Windows Explorer to the current directory and to the 

application data directory, respectively. 

What’s Fixed 
• Fixed numerous bugs and issues. 

 

  



FiberChekPRO 2.0.0 (Maintenance Release 4) 

Version 2.0.0.4980 – August 2017 

What’s New 
• New firmware: 

• FVDi/FVAi Series – 1.3.1132.2932 

What’s Fixed 
• Minor bug fixes. 

 

FiberChekPRO 2.0.0 (Maintenance Release 3) 

Version 2.0.0.4925 – July 2017 

What’s New 
• New firmware: 

• FiberChek Video Inspection Probe – 1.3.769.2870 

What’s Fixed 
• Minor bug fixes. 

 

FiberChekPRO 2.0.0 (Maintenance Release 2) 

Version 2.0.0.4888 – June 2017 

What’s New 
• New firmware: 

• FVDi/FVAi Series – 1.3.1128.2871 

What’s Fixed 
• Minor bug fixes. 



FiberChekPRO 2.0.0 (Maintenance Release 1) 

Version 2.0.0.4884 – June 2017 

What’s New 
• New firmware: 

• FVDi/FVAi Series – 1.3.1126.2871 

What’s Fixed 
• Minor bug fixes.  



FiberChekPRO 2.0 

Version 2.0.0.4875 – June 2017 

What’s New 
• Test Mode feature with two modes: 

• Quick Test Mode – the classic FiberChekPRO test workflow where results are saved individually. 

• Job Workflow Mode – Multiple results are grouped into a consolidated report. 

• Either sequential, open-ended test numbering or fixed, preconfigured test names. 

• Allows any number of work-in-progress jobs, and can freely switch between jobs for 

better workload flexibility. 

• Work-in-progress jobs may be transferred between computers to allow technicians to 

share workloads. 

• See separate “What’s New” document on UpdateMyUnit.net for more information. 

• New firmware: 

• P5000i – 1.6.1186.2872, 1.6.240.2872 

• Patch Cord Module of Smart Class Fiber devices except OLP-82P – 1.6.240.2872 

• OLP-82x/HD4ix Series – 1.6.1140.2852 

• FVDi/FVAi Series – 1.3.1125.2871 

• FiberChek Video Inspection Probe – 1.3.767.2870 

• FBPP-WIFI Wireless Adapter – 1.3.167.2801 

What’s Changed 
• The File menu (which was previously accessed by clicking on the check mark icon in the upper-left 

corner of the window) moved to the menu bar, to the left of the Setup and Help menus. 

• The check mark icon in the upper-left corner of the window was removed and replaced by the Test 

Mode menu, which indicates the current mode and allows user to switch modes. 

• Report Layout option removed from the Archiving Options setup page because it is now controlled by 

the new Test Mode feature. The old Standard report layout corresponds to the new Quick Test mode, 

and the old Consolidated report layout corresponds to the new Job Workflow mode. 

• Start Job… removed from the File menu because that functionality was rolled into the new Job 

Workflow. 

• Default install location changed to “C:\Program Files (x86)\Viavi\FiberChekPRO” on 64-bit machines and 

“C:\Program Files\Viavi\FiberChekPRO” on 32-bit machines. If the machine already has an installation of 

version 1.9 or earlier, version 2.0 will install in the previous location  (“C:\Program Files 

(x86)\JDSU\FiberChekPRO” on 64-bit machines and “C:\Program Files\JDSU\FiberChekPRO” on 32-bit 

machines). 



• Default Archives location changed to “C:\Users\<username>\Documents\Viavi\FiberchekPRO\Archives”, 

where <username> is the current Windows user name. However, if the machine already has an 

installation of version 1.9 or earlier, version 2.0 will use the previous Archives location. 

• Application data location (where logs, user preferences and analysis profiles are stored) changed to 

“C:\ProgramData\Viavi\FiberChekPRO”. 

• Changed the default lighting values for the FiberChek and P5000i ULC-A6 optical settings. 

• Window frame color changed to Viavi Purple, and window close, minimize, and maximize buttons 

changed to the Windows 10 style. 

What’s Fixed 
• Various bug fixes and reliability improvements. 

Firmware Release Notes 

P5000i – 1.6.1186.2872, 1.6.240.2872 

What’s New 

• Reduced analysis time by up to 30%. 

OLP-82x/HD4ix Series – 1.6.1140.2852 

What’s New 

• Reduced analysis time by up to 30%. 

FVDi/FVAi Series – 1.3.1125.2871 

What’s New 

• New language packs – German, Spanish, French, Italian, Japanese, Korean, Portuguese, Russian, 

Vietnamese, and Chinese 

• Reduced analysis time by up to 30%. 

• Autofocus is now faster and more reliable. 

• Instrument starts up quickly, even when there are a large number of stored test results. 

• The Autofocus on Insert delay has been slightly increased to allow more time for a user to insert the 

fiber and to improve Autofocus results. 

FiberChek Video Inspection Probe – 1.3.767.2870 

What’s New 

• New language packs –German, Spanish, French, Italian, Japanese, Korean, Portuguese, Russian, 

Vietnamese, and Chinese 

• Reduced analysis time by up to 30%. 

• Autofocus is now faster and more reliable. 

• Instrument starts up quickly, even when there are a large number of stored test results. 

• Profile changes via connected host are now reflected in real time on the FiberChek UI. 



  



FiberChekPRO 1.9.2 

Version 1.9.2.4711 – December 2016 

What’s New 
• Support for MP-60/MP-80 connected via the FBPP-WIFI Wireless Adapter. 

• PON threshold sets management for OLP-87x devices. 

• New “Device Information” page in the setup screens for P5000i, OLP-82x/HD4ix, FVDi/FVAi, FiberChek, 

and FBPP-WIFI Wireless Adapter devices. 

• New “Power Options” section in the setup screens for FiberChek and FBPP-WIFI Wireless Adapter 

devices. 

• New “User Info” page in the setup screens for OLP-82x/HD4ix, FVDi/FVAi, and FiberChek devices where 

you can view and edit the info stored on the device. 

• Live operation of an MP-60/MP-80 attached to a FiberChek probe. 

• New firmware: 

• P5000i – 1.6.1182.2742, 1.6.228.2742 

• Patch Cord Module of Smart Class Fiber devices except OLP-82P – 1.6. 228. 2742 

• OLP-82x/HD4ix Series – 1.6.1119.2742 

• FVDi/FVAi Series – 1.3.1035.2773 

• FiberChek Video Inspection Probe – 1.3.615.2741 

• FBPP-WIFI Wireless Adapter – 1.3.155.2699 

What’s Changed 
• Changed the order of pages in the setup screens for P5000i, OLP-82x/HD4ix, FVDi/FVAi, FiberChek, and 

FBPP-WIFI Wireless Adapter devices to be more consistent with each other. 

What’s Fixed 
• Numerous bug fixes and reliability improvements. 

Firmware Release Notes 

FVDi/FVAi Series – 1.3.1035.2773 

What’s New 

• Added detection logic for scratches extending through core 

• Added ability to run autofocus calibration 

• Profile and tip names display on the results page 



FiberChek Video Inspection Probe – 1.3.615.2741 

What’s New 

• New menu for User Info 

• New menu for Date and Time 

• New menu for Grouping 

• New menu for Fiber ID Base name 

• On-device autofocus calibrations 

• Full OPM integration 

• Restricted power mode (no motor movement) when battery is low 

• Expanded Microscope Settings Menu to include Centration Limit 

• Joystick will no longer clears an error message 

• Joystick cancelling autofocus will no longer show an error message 

• UI added pop-up notification upon locked resource 

• Error messages should be more precise 

• Can now store up to 20 optical settings 

P5000i – 1.6.1182.2742, 1.6.228.2742 

What’s New 

• Can store up to 20 optical settings 

OLP-82x/HD4ix Series – 1.6.1119.274 

What’s New 

• Tip and profile selection is now persistent 

• Analysis profiles upgraded to the IEC 2.0 specification. 

• Modulated frequency calculation is now more accurate 

FBPP-WIFI Wireless Adapter – 1.3.155.2699 

What’s New 

• Added support for hosting MP-60/80 OPM devices 

• Auto-off is prevented if a host is communicating with an attached device.  



FiberChekPRO 1.9.1 (Maintenance Release 3) 

Version 1.9.1.4632 – October 2016 

What’s Changed 
• New Firmware 

• FiberChek Video Inspection Probe – 1.3.556.2695 

FiberChekPRO 1.9.1 (Maintenance Release 2) 

Version 1.9.1.4578 – September 2016 

What’s Changed 
• New firmware 

• FVDi/FVAi Series – 1.3.964.2695 

• FiberChek Video Inspection Probe – 1.3.521.2695 

What’s Fixed 
• Minor bug fixes. 

FiberChekPRO 1.9.1 (Maintenance Release 1) 

Version 1.9.1.4567 – September 2016 

What’s Changed 
• The FiberChekPRO Diagnostics tool now has the option to limit the resulting file size for easier email 

transfer. 

What’s Fixed 
• Bug fixes and performance improvements. 

 

  



FiberChekPRO 1.9.1 

Version 1.9.1.4545 – August 2016 

What’s New 
• Support for the new FBPP-WIFI Wireless Adapter. (Currently the P5000i is the only device supported by 

the adapter.) 

• New firmware: 

• P5000i –  1.6.1179.2665, 1.6.222.2665 

• Patch Cord Module of Smart Class Fiber devices except OLP-82P  – 1.6.222.2665 

• FVDi/FVAi Series – 1.3.942.2661 

• FiberChek Video Inspection Probe – 1.3.487.2666 

• MP-60/80 & VP-60/80 – 1.28 

What’s Changed 
• Fiber inspection reports now display the microscope’s serial number for P5000i, Smart Class Fiber Patch 

Cord Modules, FVDi/FVAi Series, and FiberChek Probe microscopes. (Inspections imported from device 

storage do not yet display the serial number.) 

• FiberChek Video Inspection Probe’s display name now matches its Wi-Fi SSID 

What’s Fixed 
• Minor bug fixes. 

 

FiberChekPRO 1.9.0 (Maintenance Release 2) 

Version 1.9.0.4448 – June 2016 

What’s New 
• New firmware: 

• FiberChek Video Inspection Probe – 1.3.439.2616 

What’s Fixed 
• Minor bug fixes. 



FiberChekPRO 1.9.0 (Maintenance Release 1) 

Version 1.9.0.4425 – June 2016 

What’s Changed 
• Users can now import optical settings to a P5000i that were exported from a FiberChek, and vice versa. 

What’s Fixed 
• Minor bug fixes. 

FiberChekPRO 1.9.0 

Version 1.9.0.4410 – June 2016 

What’s New 
• Support for the new the FiberChek Video Inspection Probe over USB and Wi-Fi 

• New firmware: 

• FVDi/FVAi Series – 1.3.906.2601 (Note to users: connect your device to a PC/laptop with 

FiberChekPRO 1.9.0 installed to update firmware.) 

• MP-60/80 & VP-60/80 – 1.27 

• Low mag live view of FVDi/FVAi Series with latest firmware shows centering limit overlay ring if enabled 

on the device. 

What’s Changed 
• Changed branding and logos from JDSU to Viavi. 

• Users may now remove (but not edit) IEC profiles from devices that store them. 

• Minor bug fixes. 

FVDi/FVAi Firmware Changes 

What’s New 

• Added an overlaid circle on microscope live view to indicate the user specified fiber centering limit. May 

be enabled/disabled through the Microscope Settings menu. 

• Users may now toggle the mode of a new combined Capture/Test button for VGA output mode. Desired 

mode is selected through the Microscope Settings menu. 

What’s Changed 
• Source button now only shows when extra sources are currently available. 

• More robust image acquisition for sharper images and more accurate test analysis. 

• Minor bug fixes.  



FiberChekPRO 1.8.2 

Version 1.8.2.4347 – April 2016 

What’s New 
• New firmware: 

• FVDi/FVAi Series – 1.3.887.2539 

• Added support for Smart Class Fiber (except OLP-82x/HD4ix series) firmware V01.28.00 and higher 

 

FiberChekPRO 1.8.1 

Version 1.8.1.4212 – February 2016 

What’s New 
• New firmware: 

• P5000i –  1.6.1175.2506, 1.6.220.2506 

• OLP-82, OLP-82P, HD4i, & HD4iP – 1.6.1098.2506 

• PCM of SCF devices except OLP-82P  – 1.6.220.2506 

• FVDi/FVAi Series – 1.3.865.2511 

 

FiberChekPRO 1.8.0 

Version 1.8.0.4015 – December 2015 

What’s New 
• Report generation and StrataSync support for the OLTS-85 device. 

• Project-based report generation for SCF devices (except OLP-82, OLP-82P, HD4i, & HD4iP) 

• StrataSync support added for p5000i, OLP-82, OLP-82P, HD4i, HD4iP, PowerChek, VP-60/80, and MP-

60/80 

• New firmware: 

• P5000i –  1.6.1166.2437, 1.6.208.2437 

• OLP-82, OLP-82P, HD4i, & HD4iP – 1.6.1087.2437 

• PCM of SCF devices except OLP-82P  – 1.6.208.2437 



What’s Changed 
• Default save location for p5000i images and inspection reports changed to: 

• PATH\P5000i_SerialNumber 

• where PATH is the archives location set in the Archiving Options and SerialNumber is the  

device's serial number. 

• Default OPM log file changed to: 

• PATH\MODEL_SerialNumber\OPMLog_YYYYMMDD.csv 

• where PATH is the archives location set in the Archiving Options, MODEL is the device 

model (such as MP-60), SerialNumber is the device’s serial number, and YYYYMMDD is 

the current year, month and day. 

• Optimizations to reduce memory usage and improve performance 

• Installer: 

• The installation of Adobe Reader is now an optional component that can be 

checked/unchecked. 

• DirectX 9 is now only installed if Model 1100 driver selected and the machine is 32-bit. 

What’s Fixed 
• Various bug fixes, improvements and optimizations. 

 

  



FiberChekPRO 1.7.1 

Version 1.7.1.3883 – October 2015 

What’s New 
• Added Windows 10 support: 

• New drivers for P5000i, OLP-82, OLP-82P, HD4i, and HD4iP 
• FiberChekPRO now correctly identifies the operating system as Windows 10. 

• New analysis profiles reflecting the June 2015 publication of the IEC-6130-3-35 standard: 

Complete List of Installed Default Profiles  

E2000 (metal ferrule) 

MM (IEC-61300-3-35 Ed. 1.0) 

MM (IEC-61300-3-35 Ed. 1.0)-Benchtop 

MM (IEC-61300-3-35 Ed. 2.0) 

MM (IEC-61300-3-35 Ed. 2.0)-Benchtop 

Ribbon, MM (IEC-61300-3-35 Ed. 1.0) 

Ribbon, MM (IEC-61300-3-35 Ed. 1.0)-Benchtop 

Ribbon, MM (IEC-61300-3-35 Ed. 2.0) 

Ribbon, MM (IEC-61300-3-35 Ed. 2.0)-Benchtop 

Ribbon, SM APC (IEC-61300-3-35 Ed. 1.0) 

Ribbon, SM APC (IEC-61300-3-35 Ed. 1.0)-Benchtop 

Ribbon, SM APC (IEC-61300-3-35 Ed. 2.0) 

Ribbon, SM APC (IEC-61300-3-35 Ed. 2.0)-Benchtop 
 

SFP Ball Lens 

SFP Fiber Stub (IEC-61300-3-44 Ed. 1.0) 

SFP Special/Flat Lens 

SM APC (IEC-61300-3-35 Ed. 1.0) 

SM APC (IEC-61300-3-35 Ed. 1.0)-Benchtop 

SM APC (IEC-61300-3-35 Ed. 2.0) 

SM APC (IEC-61300-3-35 Ed. 2.0)-Benchtop 

SM PC & Fiber Stub (IEC-61300-3-35 Ed. 2.0) 

SM PC (IEC-61300-3-35 Ed. 1.0) 

SM UPC (IEC-61300-3-35 Ed. 1.0) 

SM UPC (IEC-61300-3-35 Ed. 1.0)-Benchtop 

SM UPC (IEC-61300-3-35 Ed. 2.0) 

SM UPC (IEC-61300-3-35 Ed. 2.0)-Benchtop 
 

• New firmware: 
• P5000i –  1.6.1159.2357, 1.6.200.2357 
• OLP-82, OLP-82P, HD4i, & HD4iP – 1.6.1075.2328 
• PCM of SCF devices except OLP-82P  – 1.6.200.2357 

What’s Fixed 
• Various bug fixes, improvements and optimizations. 

  



FiberChekPRO 1.7 

Version 1.7.0.3760 – August 2015 

What's New 
• Updates to Focus Quality Meter: 

• New red-yellow-green focus bar. 
• Red = Unacceptable focus (Testing disabled when focus is in the red) 
• Yellow = Acceptable focus 
• Green = Optimized focus 

• Focus value included on reports 
• Normalized focus quality scale 

• Normalized across all microscopes, magnifications, and lighting conditions.  
• A fully focused image make the meter nearly full 
• Focus quality scale follows a 0-100 value 

• Note: Firmware update is required to enable this feature on P5000i and Smart Class Fiber patch 
cord modules. 

• StrataSync report management for select Smart Class Fiber hand-held devices (OLP-87, OLP-87P, OLP-
85, OLT-85, ORL-85). 
• StrataSync licenses are required to support each device 
• Request a quote for a device license directly from FiberChekPRO 
• Sync option available in 2 places: 

• Import Tab 
• Setup > StrataSync menu 

• Users can sync imported data even without device connected 
• Optimizations for data import from all Smart Class Fiber hand-held devices: 

• New option to import only new data. (Enabled by default.) 
• Improved file name conflict handling: 

• If the destination folder already has report data in it and there are file name conflicts, for 
each file the user is given the following options: 

1. overwrite the file 
2. rename the file  
3. skip the file 
4. cancel all imports 

• New option to show imported files in Windows Explorer after import completes. (Enabled by 
default.) 

• Can now export and import Profiles, allowing them to be transferred between machines. 
• Go to: Setup > FiberChekPRO Setup > Analysis Profiles > Show Advanced Options 

• Can now export and import Optical Settings, allowing them to be transferred between machines. 
• Go to: Setup > P5000i setup > Optical Settings > Show advanced options 

• New Report Options: 
• Option of whether or not to included individual fiber details on consolidated PDF report. 

(Enabled by default.) 
• Option of whether or not to merge details into one PDF document. (Enabled by default.) 

• All device drivers are now signed, eliminating challenges associated with installing unsigned drivers on 
Windows 8. 



• Lower memory usage when generating consolidated PDF reports, allowing for larger reports to be 
generated given the computer's available RAM. 

• New "Save and Exit…" menu item when using a Job Definition or the consolidated report workflow. 
This provides the user the assurance that tests are saved when exiting the app. 

• GPS coordinates are now included on the fiber inspection report if the computer has a GPS sensor. 
Note: This only applies to reports generated directly in FiberChekPRO, not those imported from hand-
held devices. 

• Analysis Profiles: 
• New optional exclusion zone. For each zone, user may specify an inner and outer radius in which 

defects and scratches are not counted towards the acceptance criteria. 
• About box now has link to the licenses for the open source software used by FiberChekPRO. 
• Fiber inspection is now noticeably faster due to optimizations. 
• 6 new SFP optical settings for P5000 and 3 new SFP optical settings for P5000i 
• New P5000i USB settings: 

• New page in the P5000i device setup screen allows selection of USB settings: 
• USB 1.1 - The probe will always connect in USB 1.1 speed. 
• USB 2.0 - The probe will always attempt to connect in USB 2.0 speed. If that fails it will fall 

back to USB 1.1 for the current session. 
• Auto - The probe will connect in USB 1.1 first. Then FiberChekPRO will attempt to reset it 

into USB 2.0. If that fails it will fall back to USB 1.1 for the current session. Note: this is the 
default setting and is the same behavior as earlier software versions. 

• Note: these USB settings are only available after updating to the current firmware version. 
• New firmware: 

• P5000i –  1.6.1144.2303, 1.6.190.2303 
• OLP-82, OLP-82P, HD4i, & HD4iP – 1.6.1072.2303 
• PCM of OLP-87P, OLP-85P & OLT-85P  – 1.6.190.2303 

What's Changed 
• Import: 

• Default import destination changed to: 
• PATH\MODEL_SerialNumber\YYYYMMDD 

• where PATH is the archives location set in the Archiving Options, MODEL is the 
device model (such as OLP-82P), SerialNumber is the serial number on the device's 
label, and YYYYMMDD is the current year, month and day. 

• Each successive import operation for a given device on a given day goes into the SAME 
folder. By default, only the new data is imported. 

• Now only report types that are actually supported by the device are shown in the Stored Data 
pane on the Import tab. 

• Optical Settings Setup: 
• If password protection is applied, password prompt occurs upon new, edit, copy, or delete 

operations, allowing user to move optical settings left, right, up and down without the 
password. 

• "Save" file menu item changed to "Save Image" to reflect what it actually does. 
• OLP-87 and OLP-85 PON and power meter reports now say “Report Date” in the header instead of 

“Inspection Date”. 



What's Fixed 
• Numerous bug fixes, improvements and optimizations. 


